COMPUTER FUNDAMENTALS

What is a computer?

A computer is a tool or instrument that helps in computation. Computation includes addition,
subtraction, multiplication, division, comparison of numbers, manipulation of texts, logical
decisions etc. We use calculators in our routine for carrying out calculations. However, the
scope of application of a calculator is thus very limited. A computer, in contrast, can store a
series of instructions and huge information and data in its memory and process a complete

job.

Efficiency of the computer depends on the set of instructions given to it. It exactly does what
it has been told to do. Precise, clear and correct instructions should be given to the computer
to enable it to carry out the operations correctly. When the instructions are faulty and not
clear, the results produced by the computer will also be faulty and not clear. This
phenomenon of wrong output of data due to wrong input of instructions/data is termed as
Garbage in Garbage out (GIGO).

What are the advantages of computer?

e Very high speed processing

e large capacity for storage and retrieval of data
e Perfect accuracy

e Automatic working capability

e Diligence

e Versatility

What are the limitations of computer?

e (Can not think on its own

e Can not learn by experience

e Can not take independent decisions on its own.

e Requires human intervention for each any every step



Explain the evolution of computers.

Increasing need for numerical calculations, storage of data and information etc. with minimum
of mental and manual efforts led to invention of computers.

e ABACUS, used for calculations, was the earliest devise that qualifies as a computer widely
used 6000 years ago. The ABACUS was built using the idea of place values.

e John Napier developed Logarithm, a tabular system of numbers through which many
arithmetical calculations were simplified, in 1617.

e Napier also invented a set of rods which were carved from bones and used for
multiplication. These were called Napier Bones.

e Slide Rule, based on the principle of logarithm, a calculating device was invented by
William in 1620.

e Blaise Pascal, a Frenchman, invented a mechanical unit in 1642 that could add and
subtract, using a set of toothed wheels. This ‘calculator’ was the first digital machine.

e Pascal’s machine was further improved by a German mathematician Gottfried that could
add, subtract, multiply, divide and extract roots.

e In 1822, Charles Babbage built the ‘Difference Engine’. This could do only one kind of
calculations.

e In 1833, Charles Babbage designed and worked on Analytical Engine. It was a general
purpose computer designed to solve almost any type of problem. It contained most of the
elements we find in modern digital computer systems. Hence, Charles Babbage is
considered as Father of modern computer.

e Joseph Jacquard invented punch cards in 1801. Punch card had holes punched in it. These
were used by him to produce weaving pattern on the cloths.

e In 1880, Dr.Herman Hollerith used punched cards for data processing by building a
tabulating machine that could punch holes in cards and read them as well. This machine
worked on electricity and had mechanical parts and could handle 50 to 75 cards per
minute. The system was very slow and card jams and data destruction were common
problems. Punching machine, Verifying machine, Interpreter, Sorter, Collators, Tabulator
were some of the machines used in this system.

e In 1944, Howard Alken built MARK1, the first digital computer, at Harvard University. It
lacked speed but had the ability to continuously perform complex arithmetic functions
without frequent human intervention. It was partly electronic and partly mechanical
machine.

e In 1936, Alan Turing from Cambridge University submitted his brilliant logical analysis on
‘artificial intelligence’. His contribution on the development of electronic computers
remains the single biggest contribution ever made to the science.

e In 1930, Germans developed a mechanical machine called as ‘ENIGMA’ for coding military
messages.

e |n 1939, Britain initiated to build machines that could decipher Enigma’s codes. The world’s
first giant computer using values was built called the ‘Colossus’.

e In 1942, USA started to develop an electronic computer. In 1946, it could put to operation
‘ENIAC’ (Electronic Numerical Integrator and Calculator), made in University of
Pennsylvania. John Mauchly and J.Presper Eckert were the two people involved in its



development. This computer was made of 18,000 vacuum tubes. ENIAC could process the
data at great speeds (though not comparable to today’s computers).

e UNIVAC-1 was the first business oriented computer developed in 1952 used by US Bureau
of Census.

Explain the ‘Generations of computers’.

A generation is a rough period of time over which there are no major changes or development
in that particular field. Every change in technology has been treated as a new ‘generation’ of
computers. Each generation has its own advantages and disadvantages.

First Generation Computers :

e Used vacuum tube technology. (Vacuum tube is a fragile glass device that can control and
amplify electronic signals.)

e Computers were very large in size and generated lot of heat.

e Speed was measured in milli-seconds.

e Developed many problems and required frequent maintenance.

e Performed at low speed, occupied large space, consumed more power and needed air
conditioning.

e Example : ENIAC(Electronic Numerical Integrator and Calculator) computer developed by
USA.

e EDSAC (Electronic Delayed Storage Automatic Computer) was another major development;
developed at Cambridge University of England; first introduced in May, 1946.

e Advantages : Vacuum tube technology made possible the advent of electronic digital
computers and these were the fastest calculating devices of that time.

e Disadvantages : Very bulky and non portable; lot of heat generated and so air-conditioning
compulsory; frequent hardware failures and maintenance.

Second Generation computers:

e Developedin late 1950’s.

e Used transistors in place of vacuum tubes. Transistors were smaller, less expensive and
generated less heat compared to vacuum tubes.

e Speed measured in micro-seconds.

e Magnetic tapes could be used as medium for storage of data.

e Example : UNIVAC (Universal Automatic computer) was the first commercial business
computer

e Example : IBM 1401, IBM 1410

e Advantages : Flaws of first generation computers removed; smaller in size; Faster and
more reliable; commercial production easier and cheaper.

e Disadvantages : Air conditioning required; Manufacturing process involved manual
assembly



Third Generation computers:

Developed in mid 1960’s. (1965-71)

Used LSIC (Large Scale Integrated Circuits) in place of transistors. IC was small and one IC
could do the job of hundreds of transistors.

Computers became smaller and faster

Speed measured in nano-seconds.

Magnetic drums used as medium of storage of information.

Led to development of software (called Operating System) for efficient use of computer.
Example : IBM-360 series introduced in 1964

Advantages : Smaller in size; more reliable and portable; low maintenance cost, lesser
power required.

Disadvantages : Required highly sophisticated technology for manufacturing ICs.

Fourth Generation Computers:

Introduced in 1970's

Used VLSI (Very Large Scale Integrated) Circuits containing thousands of transistors, diodes
and registers.

Roughly more than 30,000 components could be accommodated on one chip of the size of
a postal stamp.

Concept of micro-processors evolved. It is a chip of silicon known as microprocessor chip.
Could be easily placed on small table

Price reduced and affordable and became a common equipment in small business
establishments.

Advantages : Size reduced substantially; air conditioning not required; operations much
faster; more general purpose; cheapest amongst all previous generations; desktops made
available for business/personal use.

Fifth Generation and next generation computers

Based on ULSI (Ultra large scale integration) technology.

Will have tremendous processing power and speed.

Support high degree of artificial intelligence (computers will be able to think and learn and
act on their own to some extent)

Interact with humans in ordinary languages

Advantages : More user-friendly; reduced size; easy to operate; economical and faster;

programming much easier and simpler; emphasis shifted to networks and client server

technology.

Explain the classification of computers.



Computers are classified into 3 broad categories basing on — type, purpose, capacity.

Type :

Analog computers : These are measuring devices that work on volatile data. Eg. Heat,
pressure, humidity, speed etc. Eg. Thermometers, barometers, speedometers. These are
sensitive to slightest changes.

Digital computers : Deal with numbers; can be used to manipulate data with great accuracy.
Take input and give out put. Can store large quantities of data. Eg. All electronic computers,
calculators, quartz watches etc.

Hybrid computers : Mixture of analog and digital computers. Input is generally in the form of
analog form like heat/pressure etc., measured by analog part of computer and then used by
digital part for further operations. Eg. Computers used in factories for controlling
manufacturing processes, launching a rocket etc.

Purpose :

General Purpose computers : Capable of handling many kinds of operations. Used for both
business and scientific applications with equal efficiency. Can be used at any place like offices,
banks, schools etc.

Special Purpose computers : Designed to perform specific task and can not be used for other
purposes. Eg. Monitor patient’s health in hospitals, in airports to monitor arrival/departure of
flights etc.,

Capacity :

Super computers : Very large in size with very high processing speeds having more number of
processing units. These are generally used for complex scientific computations / purposes.

Main Frame Computers : These are large computer systems having capability to support
more powerful peripheral devices and terminals.

Micro computers : Micro computer is the smallest category of computers consisting of micro-
processor and associated storage and input/output devices.

Mini Computers : Relatively fast but small and inexpensive as compared to Main frame
computers. A mini computer can support 10 to 12 terminals.



Personal computers : Designed for personal use. Several models are available in the market.
These are very widely used and seen everywhere. Today these are available with very high
processing speed and large storage capacity at affordable prices.

Write about concepts of Number Systems and the data representation in computers.

As the computer is an electronic device, it works on the presence/absence of electronic signals.
Electrical energy is used only to carry information.

Computer uses a number system which is different from our usual decimal system for storing
data. It can just recognize two states — ON or OFF and numbers are represented by using
these two states i.e., by using the ON position to represent ‘1’ and the OFF position to
represent ‘0’. Therefore, a number can be simulated easily within the computer under a
number system which uses two digits only i.e, ‘0’ and “1’. This system is called Binary system.

In decimal system we use 10 digits from 0 to 9. Each decimal ‘digit’ takes one of these ten
values. The value depends on the ‘position’ of the number system i.e, units, tens, hundreds,
thousands and so on.

Binary Number system :

The binary digits (0 and 1) are used to represent data in a computer. In computer terminology,
the binary digit is called as a ‘bit’. As the computer works on electricity, the number 1
represents power on and 0 represents power off. Computers do not understand letters of
decimal numbers. They only understand 1s and Os. This is called the binary system. All the
letters of the alphabet, all numbers and all signs like +, -, = etc are converted into Os and 1s if
the computer has to work with them. The positional value of each digit has to be the power of
2ie,2* 22 27 2! 2%etc. (i.e., 16, 8, 4, 2, 1 etc.). The base of decimal system is 10 where as
the base of binary system is 2. So this is also called ‘BASE2’ number system. The base of
numbering system is called ‘Radix’. Therefore, the Radix of decimal system is 10 and that of
binary systemis 2.

Decimal to binary conversion : The decimal number is successively by 2 (base of binary
system) until division is no longer possible. At the end of each of successive division, the
remainder is written in the next column. The binary equivalent of decimal number is obtained



by writing the remainder from the bottom to the top.

Example : Find the binary equivalent of Decimal Number 30.

Base=2 Number=30 Remainder
2 15 0
2 7 1
2 3 1
2 1 1
0 1
Binary equivalent of 30 =11110

Binary to decimal conversion : Write down the place value of binary numbers, multiply the

place value with the number and add the result so obtained to get the value in decimal system.

Example : Convert the binary number 1110010 to decimal.

a) |28 22 2 22 22 2t 2° Binary base 2 place value

b) |64 32 16 8 4 2 1 Place value in decimal system

¢|1 1 1 00 10 Binary number given in the example

d |64 32 16 0 0 2 O Multiply (b) & (c) = b X c to get place values

e) |64+32+16+0+0+2+0 Add the place values to get decimal equivalent

Answer : 114 in decimal number system

We can also perform addition, subtraction, multiplication and division functions in binary

system. The following examples illustrate them :



Addition : Basic rule is — when we add two1l’s the result is 0 with a carry digit.

10101 1000001 111110
+10101 +100001 +11111
10101 100000 111110
+10101 +100001 +011111
101010 1000001 1011101

Subtraction : This can be performed by using the process of addition by adding the
complement of the number to be subtracted to the number from which subtraction is to be
made. The complement is obtained by either using 1’s complement or 2’s complement.

By using 1’s complement : 1's complement is obtained by changing all the 0’s to 1's and vice

versa. Eg. 1's complement of 10001 is 01110. The left most digit is treated as sign bit i.e, ‘0" is
+ve and ‘1’ is —ve.

Procedure :

a) Obtain the 1’s complement of the number which is to be subtracted

b) Add the numbers and add the carry bit in the result.

Example : Subtract 01000 (8 in decimal system) from 01100 (12 in decimal system)

1’s complement of 01000 : 10111

Now add 01100+10111 : 1 00011 (1 placed at distance is carry bit)

Add carry bit : 1



00100 (4 in decimal system)

As the left most bit is ‘0’, the answeris ‘+4’

By using 2’s complement : 2’s complement is obtained by adding ‘1’ to the 1's complement.
Eg. 2’s complement of 10001 is 01111 (01110+1=01111)

Procedure : a) Obtain 2's complement of the number to be subtracted

b) Add the numbers and neglect the carry bit.

Example : Subtract 01000 (8 in decimal system) from 01100 (12 in decimal system)

2’s complement of 01000 is 10111+1 = 11000

Add 01100+11000= 1 00100 (carry bit ‘1’ is neglected)

As the left most digit is ‘0’, the answer is ‘+ 4’ (00100 = 4 in decimal system)

Similarly, we can perform multiplication and division operations in binary system.

Octal number system :

The number system is based on 8 digits i.e., from 0 to 7. Therefore, it is called as Base-8
number system. This system is used by computer designers/engineers. We can get the octal
equivalent of a decimal number by dividing the decimal number successively and remainders
written from bottom to top. Eg. Octal equivalent of decimal number 135 = 207.

Hexa-Decimal System :

This number system is based on 16 elements. The first 10 digits form from 0 to 9 and the 11
to 16™ elements are represented by A,B,C,D,E,F. Therefore 10 in decimal system is equal to A



in hexa-decimal, 11 is B, 12 is C and so on. This systems is also known as Base-16 number
system. This system is used by system designers.The equivalents of some decimal numbers in
hexa decimal syster are as under :

Decimal Hexa-decimal
26 1A
27 1B
28 1C
29 1D
30 1E
31 1F
32 20

Bits & Bytes: Each 1 or 0 that a computer understands is called a bit. A group of 8 bits is
called a byte. All letters, digits and signs are stored in the computer as bytes. The standard by
which all characters (numerals, alphabets, symbols) are represented by a combination of 1s
and Os is called ASCIl (American Standard Code for Information Interchange). Computers all
over the world understand characters written in ASCIl format. A combination 8 bits is used for
representing any single character in this system. Thus the system could provide a total of 2° =
256 unique combinations. Thus a table of 256 codes was prepared and the code was assigned
to each character. The codes were numbered from 0 to 255. Earlier computers used the 8 bit
word. Today’s computers use 16-bit to 64-bit words.

Binary Coded Decimal (BCD) : Each decimal digit in a binary code is assigned a four-digit binary
code to avoid the task of converting the numbers as a whole into binary. This code is known as
BCD. This occupies more storage space than in pure binary system.

Memory Storage : This is measured in bytes.

e 1 kilobyte (KB) is equal to 1024 bytes
e 1 Megabyte (MB) is equal to 1024 KB (10,48,576 bytes)
e 1 Gigabyte (GB) is equal to 1024 MB (107,37,41,824 bytes)

Explain the ‘hardware’..

Hardware is the term given to the physical components of the computer system and various
individual pieces of equipment. Thus the key board, monitor, mouse, printers etc., all come



under the category of hardware. Therefore, different parts of a computer can be termed as

hardware. The functions of hardware are :

- toaccept and store the input data in the system.
- To process the data accepted by the system.
- To give the processed results as output to the user.

Parts of a computer : The parts of the computer can be grouped into Input devices, the

Processor and the Output devices.

a)

b)

Input devices : Key board, mouse, joystick, scanner, bar code reader etc. are called input
devices. Data and instructions need to be entered into the memory of the computer to
perform various tasks. . The input devices enable the users to input the data into the
system which is processed in the processor and delivers the output.

Output devices : These are the devices through which the computer can provide the
results to the user. Printers, Monitor etc. are output devices.

Central Processing unit (CPU) : All the computing in a computer is done by the Central
Processing Unit and the Main Memory of the computer. This is the brain of the computer.
The input from the input devices is fed into the CPU for processing. The CPU uses
software to process this input and sends the output to the output devices. CPU consists of
two parts viz.,

(i) Arithmetic and Logic Unit (ALU) and

(ii) Control Unit
Arithmetic and Logic Unit (ALU) : It is the part of the CPU that does all the arithmetic and
logical operations like addition, subtraction, multiplication, division operations such as X >
Y etc.

Control unit : It coordinates all the operations of the computer. It controls the input and
output devices, the ALU and the memory. It also ensures that instructions in the software
are carried out.

Memory Storage : The memory storage is of two types.

(1) Primary Memory and (2) Secondary Memory.

Primary Memory : This is the main memory of the computer and is linked to the CPU and is




part of the base unit. RAM and ROM are different divisions of the primary memory.

a) Read Only Memory (ROM) : This is meant for information that is
permanently required to run the computer and will remain, even if the
computer is switched off. This is important because it contains all the
information that the computer requires to start up.

b) Random Access Memory (RAM) : This is used for temporary storage. All
the data and programs required for running a process are stored here, until
the process is over. More RAM storage space can make the computer work
faster. All the data o the RAM is lost when the power is turned off.

Secondary Memory : All the data and programmes which are not running on the CPU are

stored in the secondary memory. They are copied into the RAM whenever they are required.
The commonly used secondary memory storage devices are disks and tapes. There are three
types of disks- Hard Disk, Floppy Disk and Compact Disk. Hard disks are fitted into the
computer whereas the floppy disks, compact disks can be taken out and kept outside. A floppy
can hold only 1.44 MB of information whereas compact disks can hold about 600 MB of data.
The floppy drive is referred to as 'A' drive. If there is a second floppy drive on the computer it
is referred to as 'B' drive and the hard disk is termed as 'C' drive. The alphabets D,E, F etc., are
reserved for additional hard drives that the computer may have.

Some storage devices. :

1. Floppy disk — 3 % inch diameter (previously we had 5 % inch floppy disks also) : It is
divided into concentric circles called tracks and the tracks are further divided into
sectors. There is a small hole on the disk called index hole which denotes the starting
point of the first sector. The 3 % inch floppy disks can store 1.44 MB or 2.88 MB of
information.

2. Hard Disk : The disk consists of a disk pack containing hard disks/platters stacked onto
one another. A single hard disk is made of metal and coated on both sides with
metallic oxide. Hard disks can store large volumes of data as compared to floppy disks.
Today we can see hard disks of capacity of 40 GB to 200 GB and even more. Portable
(external) hard disks are also available now.

3. Digital Audio Tape (DAT) : This is widely used in our Bank for taking backups
particularly in Bankmaster branches. It looks like an audio cassette and can store large
volume of data ranging from 2 GB to 20 GB and even more.

4. CD ROM : These are also widely used now-a-days for data storage, storing music, video
(cinemas) etc. Compact Disk (CD) can store up to 700 MB of data on it. Rewritable CDs
are also available. This is a form of optical storage.

5. DVD (Digital Versatile Disk) : DVDs also look like CDs but can store much more data
than that in CD. They can store 4.7 GB data on it. Dual layer DVDs can store almost
double the data that can be stored on a normal DVD (single layer) i.e., up to 8.5 GB.
Data recording is accomplished by burning the laser beam on CDs and DVDs.

6. Pen Drives / Flash Drives : These are also storage media ranging from 256 MB to 8 GB
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and more. These are very small and portable and easy to carry volume of data.

Explain about ‘software’.

Software : Computer can not work on its own. It must be given instructions in sequence to
work. Such instructions in any computer language is called a computer programme. Software
refers to the set of programs that control the activity of processing by the computer. The
computer software is classified into two broad categories —

a) Application software : Also known as application packages. This is a set of one or more
programs that are developed or written to do a specific job. Eg. An application package of
a company to process its sales data and to generate various sales reports.

b) System software : Set of one or programmes which are developed to control the
operation of the computer system. These programs do not solve specific problems but
they are general programs which help the user in the use of the computer system.

Hardware and software of a computer are interdependent on each other. They are like the two
sides of the same coin. The hardware cannot work on its own and the software cannot be
used without the hardware.

Explain about ‘Operating Systems’.

We need a 'system' (a software program) which helps us to use the computer effectively and
efficiently. Such a software programme is called "Operating System" (OS) software. Operating
System falls under the category of system software. A computer cannot function without an
operating system. The OS is the means by which a user can communicate with the computer.
All input and output devices, all actions and processes inside the computer are controlled by
the OS. The OS communicates the user's instructions to all the parts of the computer.

An operating system is a set of programs designed to manage the entire operations of a
computer system. It does not do any specific work but it is a general program which assists the
user by doing the following operations.
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e controlling all of the operations including input/output operations, arithmetic operations
and internal movement of information.

e Communicating with peripheral devices (printers, disk and tape devices).

e Supporting the running of other software.

There are many operating systems like Unix, Linux, Mac, MS-DOS, Windows etc.

Explain about ‘Microsoft Disk Operating System’ (MS-DOS).

MS-DOS is one of the most popular operating systems. Let us now have a look at some
important MS-DOS commands.

The command prompt : When you first turn on the computer, you will see some cryptic

information flash by. When the information stops scrolling past, you will see the following :
c:\>

This is called command prompt. The flashing underscore next to the command prompt is
called the cursor. The cursor shows where the command you type will appear. DOS commands
can be entered and executed one at a time from the DOS prompt. The commands can be
typed either in lower case or upper case. You must press 'enter' key after every command you

type.

DOS commands are basically two types. They are --

A) Internal Commands : These are a few special commands that are automtically loaded into
the computer memory when the system is booted. Some important internal commands
are listed below :

B) External commands : These are some of the DOS commands that are stored as files on the

DOS system disk.

Some important and commonly used commands are briefly explained below:

1. DIR (Directory) : Displays a list of the files and subdirectories that are in the directory
you specify. When used without parameters or swithces it gives the particulars such
as file extension, file size in bytes, date and time the file was last modified, total
number of files listed, their cumulative size and free space remaining on the disk.

2. MD or MK DIR (MAKE DIRECTORY) : Used to create another directory in the drive in
which we are working presently.
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3. CD (CHANGE DIRECTORY) : We can switch over in to another directory from the
present directory with the help of this command.

4. TYPE : With the help of this command we can view the contents of a file.

5. REN (RENAME) : Used to change the name of afile.

6. DEL (DELETE) & ERASE : to delete unwanted files from the directories this command is
used. This command can be used in the following way.

7. RD or RMDIR (REMOVE DIRECTORY) : Used to remove the directory permanently
from the computer. Syntax at the prompt is : RD <directory name>. However, before
removing the directory, all the files in the directory have to be deleted by using del or
erase command. Then only the RD command works and removes the directory from
the computer.

8. COPY : This is one of the most useful commands. To copy a file from one place to
another place this command is used. Also used to store files on to floppy disks.

9. DATE and TIME : These commands are used to see the current date and time. The
date and time can also be changed using these commands if necessary.

10. FORMAT : Creates new root directory and file allocation table for the disk. It can also
check for bad areas on the disk and it can delete all data on the disk.

11. UNFORMAT:Restores a disk that was erased by using ‘Format’ command.

12. DISKCOPY : Copies the entire contents of one floppy disk to another floppy disk.
Diskcopy writes over the existing contents of the destination disk as it copies the new
information to it.

13. XCOPY : Copies directories, their subdirectories and files except hidden and system
files. With this command, you can copy all the files in a directory including the files in
the subdirectories of that directory. XCOPY source [destination]

14. SORT : Reads input, sorts data and writes the results to the screen, a file or another
device. SORT acts as a filter reading characters in a specified column and rearranging
them in ascending or descending order.

15. TREE : Graphically displays the structure of a directory.

16. EDIT : Starts MS-DOS editor, a text editor which is useful to create and edit ASCII text
files. MS-DOS editor is a full screen editor that allows you to create, edit, save and
print ASCII text files.

17. DELTREE : Deletes a directory and all its files and subdirectories.

18. FIND : Searches for a specific string of text in a file or files.

19. HELP : Starts MS-DOS help.

20. MOVE : Moves one or more files to the location you specify. Can also be used to
rename files and directories.

21. PATH : Indicates which directories MS-DOS should search for executable files
(programs).

22. PRINT : Prints a text file.

23. SCANDISK : Checks disks for damage and repairs them, if needed.

24. DEFRAG : Recognises the files on a disk to optimise disk performance. (This command
shall not be used while you are running Windows .)

25. CLS : Clears the screen.

What are wild characters?
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WILDCARDS : A wildcard is a character that can represent one or more characters in a file

name. If you want to carry out a task for a group of files whose names have some thing
common, you need not use the same command repeatedly for each file name in the group.
Wildcards can be used to specify groups of files. Two wildcards are used in MS-DOS. They are
“*’ (asterisk) and *?’ (question mark). The **’ represents one or more characters that a group
of files has in common whereas the “?’represents a single character that a group of files has in
common.

Eg. *.txt - represents all files having a “.txt” extension.
letter.*- all files named “letter” with any extension

R*.* - all files beginning with letter ‘R’ regardless of their extension

If **"is used, when you specify a file name, MS-DOS ignores letters that come after the
“* up to the dot (.). Eg. *m.exe would have the same result as *.exe has. Similarly, if the "*’ is
used in the extension, DOS ignores the letters that apper afterward. Eg. Letter.*xt would have
the same result as letter.*.

Explain about the ‘Windows’ operating system.

This is a simple Operating System to learn and use. The user need not memorise or type many
commands. We find small pictures called icons on the screen which can be used to run
programs. This is called GUI (Graphic User Interface). Microsoft Inc. of USA developed the
Windows Operating System. It has undergone many versions such as Windows 95, Windows
98, Windows ME, Windows 2000, Windows XP and the latest version is Windows Vista.

When we switch on the computer, the OS is the first software programme that is
loaded. This is called booting. After the process of booting first the Windows opening screen
and then another screen called Windows Desktop appears. The small pictures on the desktop
are called icons. The icons represent application software that are stored in the computer.
The name of the program is written below the icon.

At the bottom of the desktop we find a grey coloured strip called task bar. On the left



of the task bar is a button named Start. The right side of the task bar shows the time. The task
bar shows all the programs that are currently running on the computer.

Mouse : We find an arrow shaped pointer on the screen, the movement of which is controlled
by moving the mouse. The mouse has two buttons on it. Clicking the left button once
indicates a choice or selection. Clicking the left button twice in rapid succession causes the
selected application or command to run or begin operation.

When we click on the start button on the task bar, a box with a list of options opens
up. This is called a Menu. As you move the mouse over the choices in the menu, the item
below the pointer is highlighted.

Window : A window is the part of the desktop that is used by an application software. All
application programs that we use will have a window.

A window has six important parts.

e Border

e Title Bar - contains minimize, maximize, close buttons

e Menu Bar - contains menus with options for different tools

e Tool Bar - contains icons of the tools of application which
0 are frequently used.

e Large empty white portion - actual working area

e Status Bar - at the bottom of the window.

Files & Folders : When you draw a picture or write a letter using a computer, this picture or
letter is stored in digital form as a file. A file is a unit of stored data or programs. It has a file
name and a type for identifying it. The names may contain file extensions.

A collection of files kept together is called a folder. It can contain files of many types.
Just as files, folders also have names. Folders do not have extensions. A folder can have sub-
folders inside it. (Sub-folders are folders within folders.)

Windows Explorer : Windows explorer is an application in Windows 98 which is very useful




for finding, storing and working on files and folders stored on the computer. You can directly
open files and folders, create, copy, rename and delete files.

To open Windows explorer,
Click on the Start button.

Click on programs 2>Windows Explorer

The explorer window opens. It has a title bar, a menu bar and a tool bar. Below these,
the window is divided in to two halves with a status bar at the bottom.

The left pane shows the different disk drives and folders starting from the desktop.
The view seen in the left pane is called a file structure and can be compared to an inverted
tree. If you consider the desktop icon as the base of the tree, then all the other folders and
drives are the branches. Clicking on any of these drives or folders willopen the folder and
shows its contents in the right pane. The right pane shows the content of the drive (sub-
folders and files) or folder you have selected in the left pane.

In the left pane, you can see tiny boxes joined vertically containing a plus (+) sign or a
minus (-) sign. Each of these tiny boxes has a horizontal branch with a folder or drive icon
attached to it. A plus sign indicates that there are more branches or sub-folders, while a minus
sign indicates that there are no more sub-folders. If you click on any plus sign, the smaller
branches or sub-folders under that folder or drive can be seen. If you click on a minus sign, all
the smaller branches or sub-folders are hidden again.

Creating a new folder : Creating a new folder to save your files is very easy using Explorer.

Click on File on the menu bar, select New and click on Folder. A new folder is created now
and is seen at the bottom of the list showing the contents of the drive C. The name of the
folder is New Folder and it is highlighted in a different colour. Click on the highlighted name
and enter (type) the required folder name (eg. SBI) and click once outside the folder. A new
folder named SBI is created.



When you click on any of the icons in the folder box, the right screen displays the
contents of all the folders and files stored inside the icon you clicked. To oen any folder or file,
move the mouse pointer to the right screen and double click on the selected icon.

The view option : You can change the way the files and folders appear o the main display

screen of Windows Explorer. Explorer gives you four options.

Click on the View menu. It has four options.

e Large icons displays the icons in large size.

e Small icons shows the icons in small size on the display. This is useful when there are
a large number of items to be seen.

e List option shows the icons as a list.

e Details option shows the icons as list with details of each file or folder name, size,
type and when it was last opened or modified.

Working with files and folders :

Explorer allows you to manage your files and folders with ease.

Selecting files and folders : You can select a file or folder by simply clicking on it. You can
select more than one file if you wish. To select adjacent files, click on the first file. Hold the
Shift key down and click on the last file you want to select. All the files between the first and
the last one you picked will be selected. If you want to select more than one file and they are
not adjacent to each other, click on the first file. Hold the Ctrl key and pick out the other files
you want one by one.

Copy or moving files and folders : Windows allows you several ways of copying or moving
folders. You can copy or move files by :



e Dragging and dropping them

e Using the menu option

e Using the icons on the tool bar

e Using key board shortcuts

e Using the shortcut menus that pop up when you right-click on the mouse.

Drag and Drop : Select the file or folder you want to move. Keep the left mouse button
pressed. Without removing your finger from the left button, drag the icon and position it over
the folder you want this file to be dragged into. Release the button. The file or folder will be
placed in the new location.

Cut and paste : Select the file or folder. Click on the Edit menu and click cut. Open the folder
or disk where you want to put this file or folder. Click paste on the edit menu. The file or
folder that you cut has been pasted in the folder in the new location.

You can also use the icons on the tool bar to do this. After selecting the file or folder
to be cut, click on the Cut icon. Similarly, select the destination and click on the paste icon to
copy the cut file.

Copy and paste : Select the file or folder that you want to copy. Click on the Edit menu and
click copy. Open the folder or disk where you want to put this file or folder. Click paste on the
edit menu. The file or folder that you copied has been pasted in the folder in the new location.
You can as well use the Copy and Paste icons for this purpose as is done in Cut and Paste
process.

Finding files and folders : The hard disk contains hundreds of folders with many files inside

each folder. Windows has a program that will help in locating such files.

Move the mouse pointer over the start button and right click. A small shortcut menu
appears. Click on Find... A window opens where the required information is to be typed.

This utility helps you to find files in three ways :



i) Using the name and location of the file.
ii) Using the date on which it was last modified.
iii) Using some text that appears in the file.

The Name & Location option assumes that you remember at least some part of the file name.
Type the portion you remember in the file name in the box titled Named :. Choose [C:] in the
Look in box. Click Find Now button. All the files and folders containing the portion of the file
name you typed will be displayed for you to find the file you want.

The Date modified option is useful when you remember the approximate date on
which you created or modified the file you are searching for. Choose this option and ifll in the
dates between which you remember working on those files Clicking on Find Now will list all
the files created or modified between the dates you have specified.

The Advanced option can be used when you remember the file size or some line of
text contained in the file that you are looking for. The Find option is also available as part of
the Tools menu in Windows Explorer.

Some useful utilities :

Computer needs maintenance to work well. The main storage area of the computer is
hard disk. Over a period of time, there is a possibility that physical and logical errors can occur
in the hard disk. Files in the memory will also require rearranging periodically. Some of these
problems can be corrected by a few applications that help keep the memory of the computer
in order. The two most useful of these applications are the scan disk and Disk Defragmenter

SCANDISK : ScanDisk is used to check the hard disk for logical and physical errors. Wherever
possible, the damaged areas re repaired. Areas that can not be repaired are identified as bad
sectors and are not used for storage. To start ScanDisk click --

Start->Programs—>Accessories—> System Tools—> ScanDisk

The scandisk window opens. Click on the check box Automatically fix errors so that ScanDisk
automatically tries to repair any errors that are detected.

ScanDisk works in two ways. It checks all files and folders and make any corrections, if
required. This is called Standard scan. This is the option that is selected by default. It can also



scan the surface of the hard disk, repair and check for bad sectors, in addition to checking files
and folders. This is Thorough scan. You can select the drive you want to check, click on the
type of scan you want to be done on the drive and click Start. The scanning starts and on
completion, the results are displayed on the screen. Click on Close to return to the ScanDisk
Screen. Close ScanDisk. It is advisable to run ScanDisk on the computer at least once a month.

DISK DEFRAGMENTER : This application can be used to rearrange the files, remove gaps and

make clear space available on the hard disk for file storage. This will improve the performance
of the computer. To start this application —

Start->Programs—>Accessories—> System Tools-> Disk Defragmenter

The “Select Drive Window” opens. Select the drive you want to defragment and click on OK.
Defragmentation usually takes a few hours. It is advisable to run this application at least once
in a quarter.

COMPRESSING FILES : Files in computers occupy larger space and it becomes difficult to copy

them on to a floppy due to their size particularly when the file size is more than the space
available on a floppy. Also file handling will be difficult due to their larger size. Hence,
compression of a file (also known as Zipping a file) facilitates file handling and copying of files
easier. There are several programs available that compress files so that they occupy less bytes.

Zipped files occupy less space on any storage device. Hence copying files from one
device or drive to another is much faster. Another advantage is that we can group related files
into a single folder and then zip it.

Zipping a file : Files can be zipped in two ways. One method is by using Windows Explorer
and the other one is by directly using the WinZip program.

Zipping through Windows Explorer : The following steps are to be followed :

a) Open the explorer window

b) Select the file to be zipped

c) Right click on your selection

d) A shortcut menu opens and click on Add to <filename>.zip

With this the file will be zipped which occupies considerably lesser space than the



original one

To open a zipped file, you have to first unzip it. For this, select the file first and then right
click. A shortcut menu appears wherein select either of the two options —  Extractto or
Extract to Folder. In Extract to option, you have to choose the folder in which you want to
save the unzipped file. The Extract to Folder option creates a new folder with the same name
as the zipped file and saves the unzipped file in the new folder.

To zip or unzip a group of files, select all the required files and follow the above procedure.

WORDPAD : Windows 98 contains a word processor called WordPad which appears on your
Programs—>Accessories menu. WordPad contains many formatting features and can accept
documents created in several word processing programs. WordPad edits, loads and saves
documents in the following formats : Word for Windows, text documents, Rich Text Format
(RTF) documents.

WordPad contains a tool bar that you can display to help you access common commands more
easily. WordPad also supports the uses of Ruler and format bar that help you work with
WordPad's advanced editing features. It automatically wraps the text to the next line without
pressing 'enter' key at the end of each line. The text (matter typed) can be made bold, italised
and underlined with the help of B/ U letters on the format bar.

You can also change the font (a type style) as well as its size by clicking the drop-down lists and
selecting the required font from the list. Different options are available on menu bar and tool
bar for opening a file, saving, editing, printing etc.

Under the Edit menu you have the options like cut, copy, paste which are useful to move text /
copy text from one place to another place. To execute this task, you have to select the text
first and the open Edit menu and click on 'cut’ or 'copy' as the case may be. Click the mouse
outside the highlighted area. Move cursor to the required place where the cut/copied text has
to be inserted. Click 'paste' in the edit menu. You will find the text you have 'cut' or 'copied'
inserted at this point..
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NOTEPAD : NotePad also appears in the Accessories menu group but is a scaled-down
version of WordPad and offers very few of the formatting capabilities that WordPad offers.

CALCULATOR : Another useful accessory is Calculator which is very useful for carrying out
calculations without searching for a calculator in your desk. Standard and Scientific
calculations can be done through this.

Explain about computer languages / software languages.

Computer processes information under instructions from the user which are given to the
computer by way of input. These instructions can be written in one of various languages
evolved over years. The categories are —

Low level languages : As the computer can understand only binary digits 0 and 1, the

instructions in earlier years were directly written in binary codes known as machine language
or low level language. It involved a lot of effort and difficult to produce error-free
programming. The machine languages are machine/architecture dependent which is best
known to the manufacturer. The machine language is also called the First Generation
Language.

Assembly language is also a low level language where short English words were used instead of
binary codes for defining various operations. Eg. ‘Add’ is used to perform adding numbers.
These languages are Second Generation Languages. The Bankmaster Software was originally
developed using Assembly Language.

These languages allow programming flexibility but involve a lot of time and effort.

Middle level languages : These languages offer flexibility of low level language and ease of

programming of high level languages. ‘BASIC’ and ‘C” are the examples.

High level languages : These belong to third generation. They use English words for giving

instruction to the computer and can be learnt and used by any person having some knowledge
of writing programmes. Each high level language uses its own set of vocabulary and
punctuation rules called ‘syntax’. Some high level languages are :
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a) BASIC: Beginners’ All Purpose Symbolic Instruction Code. Easy to learn.

b) FORTRAN : FORmula TRANslation was the first computer language developed by IBM
in 1957. Used in engineering and scientific applications. Syntax is very rigid in
FORTRAN.

c) PASCAL : Designed for teaching computer science and used on small computers and is
better structured than BASIC.

d) COBOL : Common Business Oriented Language is the most popular business language
for data processing. We use this language even today for developing programmes.

e) C:Itis a middle level general purpose language. It is used both with Unix and DOS.
Developed in Bell Laboratories in early 1970s. C++ is Cs object oriented version.

Fourth Generation Languages : These are user friendly and easy to learn and use. These are

generally software packages. If any error occurs guiding messages are flashed on the screen to
enable the user to correct the error. SQL (Structured Query Language), Oracle, Ingress, Sybase
etc., come under this.

In addition to the languages, we have translators, interpreters, assemblers, compilers, linkers
etc., which are special programmes used to execute the instructions given in a computer
language.

Explain about internet.

Computers in an office are networked using LAN (Local Area Network). Computers in
different locations are connected by WAN (Wide Area Network). Both these network systems
are not for public use and have limited usage. The Internet is a network of thousands of
networks. Millions of computer networks are connected to the Internet network and are
available to the public.

Internet was invented by American Department of Defence in 1969. Even computers
that use different hardware and software can be connected to the Internet.

Minimum requirements for internet :



A computer

A telephone line

A Modem

An account with an Internet Service Provider (ISP)

¢ & & &

The simplest way to connect the computer to the Internet is by using a telephone line. A
modem (Modulator-Demodulator) converts the digital signals from the computer into analog
signals that the telephone lines use. The signals are transmitted over the telephone line and
are received by the modem at the other end. These signals are then reconverted into digital
signals that the receiving computer can understand.

The computer should be connected to an Internet Service Provider. VSNL, MTNL, Tata
Telecom and Satyam Online etc. are some important ISPs available. The ISP provides
username, password, dial-up numbers from the ISP. Usually the ISP gives an auto-dialler which
can be used for connecting to Internet.

The World Wide Web (Popularly known as Web) : The web is organised like a library. It has

websites and each web site has a title and a number to identify it. The title of a web site is
called a URL (Uniform Resource Locator). Itis easy to remember the URL of the web site than
its number. The URL of a web site is also called its address.

When you open a web site, you see the contents of that window. Thisis a web page. The first
web page of a web site is called the home page of that web site. A web page cvan contain
text, pictures, audio visuals etc., These are called links. Links are usually underlined or in a
different colour. When you move your mouse pointer over a link, the arrow changes to a
picture of a small hand. Using these links from the home page you can select and view the
other web pages containing the topic you want.

A browser is an application software that helps you search, view and read web sites on the
web. Internet Explorer (IE) and Netscape Navigator are the most commonly used browsers.
To see the web site of your choice, you will have to type the address of that web site in the
browser. This address is the URL of that web site.

Search Engines : These are web sites available on the internet that provide information on
any topic that you want. Search Engines contain a programme that collects information from
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other web sites. This information is then stored according to the category it belongs to. Eg.
Web sites about music will be stored in a category named Fine Arts. Examples of popular
search engines are Yahoo, Alta Vista and Google. To view a site of your choice, click on the
Address box and type the URL of that site and click on Go or press <Enter>.

The information required from the internet can be copied on to your document. This
is called downloading. You can also copy and paste text from a web page into your document
after highlighting it.

Explain about email (Electronic Mail).

E-mail is the most widely used means of communication today. Messages, pictures and even
music can be sent as e-mail over any length of distance to reach their destination computers
within minutes at a very lesser cost.

E-mail addresses are different from normal mailing addresses. An e-mail address
normally has four parts. The first part is the name of the user. The second part is the '@ 'sign.
The third part comes after the @ sign and is the name of the service provider. The final part is
the name of the domain (eg. .com, .net etc.).

Eg. stc.mptm@sbi.co.in

In this, stc.mptm is the name of the user, the second part is @, the third part 'sbi.co' is
the name of the service provider and the domain is ".in".

Sending e-mail : To send e-mail we have to use e-mail application software on your
computer. The most popular e-mail software is the Outlook Express. When you click on
outlook express on your desk top the outlook express window opens.

In the lower part of the window you find 'Folders' pane at the left side. It has a set of
folders named Inbox, Out box, Sent items, Drafts and Deleted Items. The inbox is used to
store incoming mail; the outbox is used to store outgoing mail before it is transmitted; the
sent items to store mail that has already been sent and the deleted itmes for deleted mail. The



drafts folder is used to store mail that is not yet complete.

To the right of the 'folders' pane, you find two panes. The upper pane contains the list
of mails in the folder you have chosen. The lower pane shows you the contents of the mail
selected in the upper pane.

To compose a new letter, click on the New Mail icon on the tool bar. A new window
opens for you to type your letter.

Type the e-mail address of the person to whom you want to send a mail in the To: box.
Click inside the Subject: box. Type a few words about the subject of the letter you want to
write. Do not leave the subject box empty. Click on the blank text area and type your letter.

After completing the letter, click on the Send icon on the tool bar. Within a few
seconds your mail will reach its destination if your are connected to the Internet. If you are
not connected to the Internet, the mail will be stored in your Outbox and will be sent as and
when the internet is connected.

Receiving the mail : Receiving e-mail is also very easy. After connecting to the internet, open

Outlook Express. Look for the Send/Recv button on the tool bar and click on it. A new window
opens and informs you about the incoming messages. After the messages are received fully,
this window disappears and you see a number next to the Inbox folder in the left pane,
indicating the number of messages received. Clicking on the Inbox folder will show a list of all
the mails you have received in the right upper pane. Double-clicking on any mail on this list
will show you the full mail in a new window.

Sending reply : You can send your reply using the same window. The incoming mail window's
tool bar contains an icon named Reply. Click on Reply icon. A new window opens with the e-
mail address of the person you are replying to along with your e-mail address. The Subject box
will have the same subject, but with the words Re: before it. You can change the subject if you
want by clicking on it and retyping a new subject. Click on the text part of the window and
type your reply. A copy of the original message is also available. You can either retain it or
delete it. To send the mail click on the Send icon on the tool bar. The mail will be sent as
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described earlier.

Sending attachments : You can attach documents, pictures etc. to your e-mail. These are

called attachments. To send an attachment click on Attach button (paperclip icon) on the tool
bar of your letter window. A new window opens which contains the folders in your computer.
Search for the file you want to attach, select it and click the Attach button. This window closes
and you go back to your mail window. You can see the name of the attachment and file size on
a separate Attachment box in the window.

Receiving attachments : [f there are any attachments in your incoming mail, you will see a
paper clip icon in the list of mails in your Inbox. When you open your mail you will also see a
separate Attachment box with the name and file size of the attachment. Double clicking on
this attachment will open a new window for you to save this attachment in your folder you
want. You will also have an option to view the attachment without saving it. If you choose the
Save it to disk option and then click on OK, the attachment will be saved in the folder that you
want.

Sending copies of the mail : There will be occasions where you have to send copies of the

same letter to different functionaries situated at different places. This is just like sending
carbon copies of original letter endorsed to others.

To send copies of your mail, look at the New Mail window where you are typing your mail.
Below the To: text box, there is another text box titled Cc: (Carbon copy). Type the e-mail
addresses of the other recipients in this box, each address separated by a comma. When you
complete the mail and click on send button, the mail will automatically be sent to all the
recipients. In this case, all the recipients will know who the other recipients are.

If you do not want them to know who else have received copies, you can type the addresses in
the Bcc: (Blind carbon copy) text box. In this case, only you (the sender) will know the identity
of all the recipients of mail.

Explain about Computer security / security in computer environment.



Computer security day (CSD) is observed on 30™ November every year. Security ensures
effective functionality of the computer systems and has bearing on the cost effectiveness of
the company. As the data stored in the computer systems is of utmost importance, its security
is also gains importance.

The risks with computers are — destruction, disruption/dislocation, disclosure and modification
i.e., destruction due to natural calamities, disruption/dislocation due to improper installation,
improper placement, virus attacks, access and disclosure to/by unauthorized persons and
modification of data by unscrupulous/unauthorized persons.

Our bank has already established comprehensive Information Systems Security Policies

Standards & Procedures on all important aspects of computer security, including Acceptable

Usage Policy. A few of the important policy prescriptions are mentioned below:

e Ensuring password secrecy

e Using Secure Configuration in systems

e Using Anti-Virus

e Ensuring Physical Security

e Guarding against Social Engineering (attempts by tricksters to obtain sensitive information
by gaining an employee’s trust or inadvertent disclosure by employees)

We are providing core banking solutions, and multi-channel services to our customers, both in
the domestic and foreign branches, and undertaking business process reengineering to
improve operational efficiency and enhance customer satisfaction. Therefore, it is so
important for all of us, at all levels, to resolve to adopt safe end-user practices and take
precautions to protect our computer systems.

Steps to minimise losses :

e Access to computer room restricted, computer access also restricted and user-defined,
need-based access with password protection should be given.

e Planning of proper computer site

e Notin vulnerable places like basements

e Fire protection

e Proper backup procedures for programs & data

e Backup arrangement for alternate site

e Screening of personnel

e Educate them on importance of security
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Write about data structures.

Data : Basic facts about the activities of a business. It is generally in the form of names and
numbers, time and date, weights, prices, product names, roll numbers, account numbers,
customer numbers etc.

Information : It is the set of data which has been converted or organized into a more useful or
intelligible form.

Data Processing : The term used for process of collecting all items of data together to produce
meaningful information. It is mostly associated with business and commercial work such as
banks, insurance companies, schools and so on. It involves scientific data processing. Can be
done in many ways viz., manually, semi-manual, mechanically and electronically.

Electronic Data Processing : Data is basically of two types — qualitative data and quantitative
data. Qualitative data denotes the qualities as colour, state, length etc., Both types of data
need to be recorded before they are processed to get meaningful and required output.

Fields : Raw Data exists in the form of ‘fields’. Field is the smallest unit of data which usually
represents/refers to a single property of an entity. Eg. Salary of an employee, roll number of a
student etc.

Records : Group of fields pertaining to single item of reference such as marks in various
subjects secured by a student. It is the collection of related elementary terms. A record can be
given a name by which the entire collection can be referred to. Eg. Bio-data of an employee.

File : It is a systematized self-contained collection of records or information. The files can be
termed as master files which hold data of semi-permanent nature, transaction files which are
purely temporary and are being updated continuously.

Elements of a computer file : A file consists of a number of records. Each record is made up of
a number of fields and each field consists of a number of characters.

Database : Database is a single organized collection of instructed data stored with a minimum
of duplication of data items. This is common to all users of the system but is independent of
programmes which use the data. It requires being stored on large-capacity direct-access
devices. The customer data of bank is a database, the accounts details of the customers of a
bank is a database. Database management is an important task of an organisation. The
processed data through database management systems provide more valuable and reliable
information to top management that enables decision making in framing policies and adoption
various strategies and approaches in business development. Thus database serves multiple
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applications and users.

Database management systems / Relational Database Management Systems etc., evolved for
the purpose of managing data. DBMS is a set of programmes that allow users to access and
modify a collection of inter-related files. It provides user with an abstract view of the data. The
programmes are used to define, construct and manipulate a database. A database in DBMS is
a collection of interrelated data stored together which allows multiple users to access it
simultaneously maintaining its consistency and integrity. The use of DBMS reduces data
redundancy and allows adhoc or unplanned querying on data.

Relational data model is one of the models in DBMS. In this model the database can be
represented in a simple collection of two dimensional tables otherwise known as the
Relational Database Management System (RDBMS). Today RDBMS is popular worldwide. It
represents and processes data in the form of tables called relations. The columns of the table
are called attributes and rows are called tuples. RDBMS uses SQL (Structured Query Language)
for data manipulation. Oracle we use in our Bank is an RDBMS. The data is basically arranged in
rows and columns which is easier to manipulate and process. Data is retrieved efficiently and
fast through the use of indexes. It is very flexible.

Introduction to MS-Word.

The Word Processors are software packages used to enter and correct data. WordStar, Word
Perfect, MS Word etc., are examples of word processors.

MS Word is an advanced Windows-based word processing product by Microsoft. It has a
number of special features that make it a widely used package. Some of them are —

e One can easily enter, correct and save and make a copy (print) the text.

e Automatic spell and grammar check to identify and correct spelling / grammar mistakes
while entering/typing the text.

e Find and replace option available to make global replacements in the document

e Text can be cut/copy and paste/move within / another document.

e Insertion of drawings, pictures, tables possible.

e Paragraph borders, page borders can be easily created.

e Most useful mail merge facility available by which the same letter can be sent to many
people.]

Starting MS Word :

This can be done in the following ways :

e By double clicking on the Word icon on the desktop
e By Clicking Start -> Programs -> Microsoft Word



Components of the Word screen :

A) Title Bar : Displays the name of the document that is open.The maximize/restore,
minimize and close buttons are used to resize or close the word window.

B) Vertical scroll bar : Allows to move forward and backward in the document. Up arrow
and down arrow keys can be used to scroll only one line.
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C) Horizontal scroll bar : Used if the page is too wide to fit on the screen. The buttons of
normal view, web layout view, print layout view, outline view are placed alongside the
horizontal scroll bar to facilitate change the view of the page.

D) Menu Bar : The bar where all the options are available to work with the document. To
select an item from a menu, click it and choose the appropriate option by highlighting
and clicking on it. If the menu items are in grey colour, the items are currently
unavailable.

E) Standard Tool Bar : Most frequently used options are placed as icons

F) Formatting tool bar : The options used for performing the actions in the menu bar are



G) Drawing tool bar : Contains various options available for drawing.

H) Status bar : Displays information about the position of the cursor on the document,
shows page number, section, line and column, language being used etc.

1) Work Area : Actual space available for typing, editing etc.,

Options available in various menus and their functionality :

File Menu : Open a new document, an existing document, close the existing document, Save
options, page set up, print preview, print, properties etc., are available. This is useful to open a
new document, an existing document, close an existing document. After the work is over, the
file can be saved. Page set up option is used to define page length, margins,

Edit Menu : Cut, copy, paste, paste special, office clipboard, clear, select all, find, replace, go to
options, links etc. options are available. All edit functions/options are available in this menu.

View Menu : Normal, web layout, print layout, outline views, task pane, ruler, header and
footer, full screen, zoom options are available. Tool bar option enables to get the required tool
bars on the desk top.

Insert Menu : Insertion of break, page numbers, date and time, picture, symbol, diagram, text
box, file etc., are available in this menu.

Format Menu : Formatting of font, paragraph, bullets and numbering, columns, tabs, text
direction, back ground etc., options are available.

Tools Menu : Spelling and grammar, speech, options, track changes, letters and mailing (mail
merge) etc. options available.

Table Menu : Creation of table is possible through this menu. Drawing a table, insertion,
deletion of rows, columns etc. done through this menu.

Window Menu: New window, window split etc. options are available.

Help Menu : Word help is available in this menu.

Shortcuts are available for various operations which enables the user avoid operation through
mouse each time. Shortcuts are combinations of two or three keys in the key board. It has
shortcut menus, auto correct options, online help, wizards, templates, macros etc.,



20.

Introduction to MS-Excel.

It is a Windows based spreadsheet developed by Microsoft Corporation. It includes all features
of a spreadsheet package like recalculation, graphs and functions. It provides many statistical,
financial and scientific functions. It is used in many scientific and engineering environments for
analyzing data.

Important features :

e Workbooks are the files in which worksheets related to a project are held.

e Like other applications, Excel has toolbars, shortcut menus, auto correct, online help and
wizards.

e Excel can maintain large volume of data. A worksheet can contain 65,536 rows and 256
columns and a single cell can contain a maximum of 255 characters and one workbook can
contain a maximum of 255 worksheets.

Contents of a worksheet :

Worksheets are used to list and analyse data. Data can be entered and edited on several
worksheets simultaneously and perform calculations based on data from multiple worksheets.

e Rows, columns and cells : Rows are numbered from top to bottom and columns are
labeled with letters from left to right. A cell is the intersection of a row and a column and
is referred by the column name and row number combination. Eg. first cell is referred to as
Al which means column A and row 1 etc.,

e Menus and toolbars: Like in MS Word, Excel also has Menus and various options or tasks
one can use to perform. Toolbars are usually shortcuts for menu items.

e Sheets : Excel has multiple pages labeled as Sheetl, Sheet2 and so on. These are the
worksheets where the user performs the operations. These can be renamed as per the
requirement of the user.

e Formulas : An ‘=’ sign is entered before a formula and without this sign, the entry is treated
as text label. Many arithmetic, scientific, logical operations can be performed using
formulas.

e The data entered in the cells can be edited, altered, deleted. Similarly, rows and columns
can also be added, deleted. Data can be cut/copied and pasted within the work
sheet/book or another workbook.

e The data in the excel worksheet can be represented in graphical form such as bar charts,
pie diagrams etc.

e Filter option is available to filter the data according to the column labels and contents of
similarity in the columns.

e Auto fill, auto sum options available.




Data types used in Excel :

Text data type is a combination of letters of alphabet, special characters like !, ? and numbers

Number data type consists of digits O to 9 and decimal point. Calculations can be done with

numeric data.

Date & time data type. These are taken as numbers in Excel. Dates can be entered in different

formats and calculations possible.



